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SUMMARY

Cellular traction forces influence epithelial behavior, including wound healing
and cell extrusion. Here, we describe a simple in vitro traction force microscopy
(TFM) protocol using ECM protein-coated polydimethylsiloxane substrate and
widefield fluorescence microscopy. We include detailed steps for analysis so
readers can obtain traction forces to study the mechanobiology of epithelial
cells. We also provide guidelines on when to adopt another common class of
TFM protocols based on polyacrylamide hydrogels.
For complete details on the use and execution of this protocol, please refer to
Saw et al. (2017) and Teo et al. (2020).
BEFORE YOU BEGIN

Traction Force Microscopy: A Brief Note

Traction force microscopy (TFM) is a technique that measures forces, also termed as tractions, that

cells exert on a substrate. These tractions are in the form of vectoral quantities and consist of both in-

plane (Tx and Ty) and out-of-plane components (Tz). It is important to clarify that although these

quantities are termed forces (units of Newton, N), the usual output by TFM is force per unit area,

i.e., mechanical stress (units of Pascal, Pa). This also holds true for the software we have recommen-

ded here. Tz, which cannot be neglected in general (Hur et al., 2012), is computationally and exper-

imentally challenging to derive compared to Tx and Ty.

In this introductory protocol and guide, we focus on 2D-TFM (i.e., Tx and Ty components) which still

provides important mechanical information on epithelial monolayers. For example, traction magni-

tude
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
ðTx2 +Ty2Þ

q
which tells us the average strength of this force, could be indirectly associated

with acto-myosin and stress fiber contractile strength (Rape et al., 2011). Also, the direction of local

traction vectors could be correlated with distinct modes of cell migration into cell-free regions (Kim

et al., 2013, Ravasio et al., 2015, Vedula et al., 2012) and cell extrusion (Kocgozlu et al., 2016).

Furthermore, global spatio-temporal patterns of traction forces could be used to understand

long-range collective migration of epithelial monolayers migrating into free space (Trepat et al.,

2009, Vishwakarma et al., 2018).
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KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Chemicals, Peptides, and Recombinant Proteins

Dow DOWSIL� CY 52-276 Kit Ellsworth Adhesives Australia http://www.ellsworth.com.au/product/
product_100002487978735.html

(3-Aminopropyl)triethoxysilane
(APTES)
Cat No: A3648

Sigma-Aldrich https://www.sigmaaldrich.com/catalog/
product/sial/a3648?
lang=en&region=AU

Ethanol Undenatured
Cat No: EA043-2.5L-J

Chem-Supply https://www.chemsupply.com.au/
ethanol-undenatured-100-ar-in-
square-plastic-bottle?SearchId=
3671509&SearchPos=6

Fibronectin
Cat No: PRO-448

Prospec https://www.prospecbio.com/
fibronectin_human

Pluronic F-127
Cat No: P2443

Sigma-Aldrich https://www.sigmaaldrich.com/catalog/
product/sigma/p2443?lang=
en&region=AU

TRIS - Ultra Pure Grade
Cat No: BIO3094T

Astral Scientific https://astralscientific.com.au/
products/tris-ultra-pure-grade

Experimental Models: Cell Lines

AML12 cells ATCC https://www.atcc.org/Products/
All/CRL-2254.aspx

Software and Algorithms

ImageJ-Fiji – Version: 2.0.0-rc-68/1.52h N/A https://imagej.nih.gov/ij/download.html

MATLAB MathWorks www.mathworks.com/products/matlab.
html

Microsoft Excel N/A https://www.microsoft.com/

Other

29 mm glass bottom dishes
Cat No: D29-20-1-N

Cellvis https://www.cellvis.com/_
29-mm-glass-bottom-dish-with-
20-mm-micro-well-number-1-cover-glass_/
product_detail.php?product_id=20

FluoSpheres� Carboxylate-Modified
Microspheres, 0.2 mm, dark red
fluorescent (660/680), 2% solids
Cat No: F8807

ThermoFisher Scientific https://www.thermofisher.com/order/
catalog/product/F8807#/F8807

Water bath Sonicator N/A N/A

Weigh Tray
Cat No: 71.9923.212

Sarstedt Australia https://www.sarstedt.com/
en/products/laboratory/
general-laboratory-products/
miscellaneous/
product/dmsarproducts/specificationPdf/
Product/71.9923.212/

Laurell Spin Coater Laurell Technologies https://www.laurell.com/spin-coater/

Cat No: WS-650-23B Corporation ?model=WS-650-23
MATERIALS AND EQUIPMENT
Reagent Final Concentration (mM or mM) Volume (mL or mL)

Tris solution 100 mM (w/v)
Note: Leftover Tris solution can be kept at
room temperature (~22�C–25�C) for future
use

200 mL

(Continued on next page)
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Reagent Final Concentration (mM or mM) Volume (mL or mL)

Cy-A solution 100%
Note: Excess Cy-A and Cy-B can be kept at
room temperature (~22�C–25�C) for future
use.
Note: This two-part PDMS material is
different from the more commonly used
Sylgard-184, as the viscosity of the solidified
PDMS varies less while its stiffness is varied
(Kenry et al., 2015)

50 mL

Cy-B solution 100%
Note: Excess Cy-A and Cy-B can be kept at
room temperature (~22�C–25�C) for future
use.
Note: This two-part PDMS material is
different from the more commonly used
Sylgard-184, as the viscosity of the solidified
PDMS varies less while its stiffness is varied
(Kenry et al., 2015)

50 mL

100–200 nm carboxylated nanobeads, with
fluorescence of your choice

0.05% (v/v) 5 mL

Fibronectin solution 1mg/mL (w/v) 1 mL

Pluronic 1% (w/v)
Note: Filter sterilize pluronic solution and
store at room temperature.

50 mL

Sodium Dodecyl Sulfate (SDS) 10% (w/v)
Note: Excess 10% SDS can be kept at room
temperature (~22�C–25�C) for future use.

50 mL
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CRITICAL: Mixfibronectinwellbygentlypipettingupanddown,usingwide tips.Vigorouspipet-
ting can induce the formation of fibronectin fibers (Nguyen et al., 2013), which impedes

uniform coating on PDMS substrate. One can visualize whether there is fiber formation by

using fibronectin conjugated with fluorescent proteins (https://www.sigmaaldrich.com/

technical-documents/articles/biofiles/atto-dyes-and-tracy-dyes-for-fluorescent-protein-labeling.

html)
Alternatives:Apart from fibronectin, other proteins of choice could be used as well as this pro-

tocol depends on non-specific binding to the PDMS surface (see step 20).
STEP-BY-STEP METHOD DETAILS

Polydimethylsiloxane Substrate Preparation

Timing: 2–2.5 h

Prepare polydimethylsiloxane (PDMS) mixture and coat glass bottom dishes

1. Pipette equal weights of Cy-A and Cy-B using a P1000 cut tip into a weigh tray. For example, 0.5 g

of Cy-A and 0.5 g of Cy-B.

Note: This gives rise to a substrate stiffness of approximately 10–20 kPa, measured by Atomic

Force Microscopy (AFM), (Kenry et al., 2015). To generate different substrate stiffness, other

mixing ratios can be adopted. Cy-A:Cy-B – 1.2:1 for 2–3 kPa, and Cy-A:Cy-B – 1:1.2 for 30–

40 kPa.

2. Stir PDMS mixture well with a P200 cut tip. Mixing by pipetting may be less efficient due to the

viscosity of PDMS.
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Figure 1. Schematic to Illustrate the Process of Spin-Coating a PDMS Substrate Droplet onto a Dish with a Glass

Coverslip to Achieve a Flattened Layer with Certain Height

Be sure to align the centers of the spin-coater, the PDNS drop, and the Petri dish.
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Protocol
CRITICAL: The mixed PDMS thickens within 20 min of mixing the two-part PDMS and it
is advisable to proceed to steps 3) and 4) in a similar duration. This is particularly

important when preparing multiple samples at the same time. Check section on

Troubleshooting.
3. Using a P200 cut tip, add 0.08 g (approximately 80 mL) of PDMSmixture onto a glass bottom dish.

Note: Pipette amount by weight and not volume as PDMS is viscous. This weight does not

need to be changed if dishes of similar size or bigger are used. Ensure that the mixture is drop-

ped at the center of the dish to generate an even layer of substrate coating. The drop would

have a diameter of approximately 0.5–1 cm before spin coating.

4. Spin coat at 500 rpm for 30 secs to generate a substrate thickness of >100 mm (Figure 1) (Yoshie

et al., 2019).

Note: As the software assumes cells exert forces on an infinite half-plane, this thickness was

chosen such that cells are less likely to sense the stiff glass surface at the bottom, allowing

this assumption to be better met (Buxboim et al., 2010, Tusan et al., 2018). At the same

time, this allows relatively flat PDMS to be fabricated.

5. Cure PDMS substrate for 2 h at 80�C.

CRITICAL: Be sure there are no obvious bubbles in the PDMS prior to curing. Check sec-
tion on Troubleshooting.
Pause Point:Once PDMS is cured, proceed to the next steps, or seal the dishes with parafilm

and store at room temperature (�22�C–25�C) for future use. The solidified PDMS in the dishes

can be kept for 1–2 months without significant deterioration.
Prepare PDMS Surface for Bead Incubation

Timing: 40 min–1 h
Silanize PDMS Surface

6. Prepare 5% (v/v) APTES solution in 100% ethanol.
STAR Protocols 1, 100098, September 18, 2020
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Note: APTES is sensitive to moisture and should be stored by filling the pocket of gas in the

bottle with inert gas such as nitrogen. The solution should be prepared fresh. Do not keep any

unused solution.

7. Add 2 mL of 5% APTES solution on cured PDMS dish for 10 min.

8. Remove 5% APTES solution and wash PDMS dish 3 times with 3 mL of 100% ethanol.

Note: The surface is soft and slightly sticky, be careful not to pipette vigorously close to the

surface nor touch it, in order to not generate unwanted plastic deformations.

9. Dry PDMS dish at 80�C for 30 min with the lid ajar.

Prepare Nanobead Solution

Timing: 30 min

10. Prepare 5 mL of 0.05% (v/v) beads in distilled water.

11. Sonicate bead solution at around 50–60 Hz for 10 min.

Note: Check section on Troubleshooting.

12. Filter bead solution through a 0.45 mm filter.

Functionalize PDMS with Nanobeads

Timing: 45 min–1 h

13. Incubate PDMS dish with bead solution for 5 min at room temperature (�22�C–25�C).
14. Remove bead solution and wash PDMS dish 3 times with 3 mL of distilled water.

Note:During washing, care should be taken to not have any parts of the PDMS dry at any time,

which can generate streaks and non-uniform bead distribution.

15. Dry dish at 80�C for 15 min with the lid ajar.

16. Incubate dish with 3 mL of 100 mM Tris solution for 10 min at room temperature (�22�C–25�C).
This is to inactivate the bead surfaces.

17. Remove Tris solution and wash PDMS dish 3 times with 3 mL of distilled water.

18. Dry dish at 80�C for 15 min with the lid ajar.

Note: PDMS dish coated with beads should be protected from light from here on. For

example, keep dishes in an opaque box or a container wrapped with aluminum foil.

Coat PDMS Dish with Fibronectin and Seed Cells

Timing: 1–2 h

19. Prepare 50 mg/mL of fibronectin solution in distilled water or 13 PBS.

20. Add 2 mL of fibronectin solution to PDMS dish. Incubate PDMS dish at room temperature

(�22�C–25�C) for 1 h.

Note: Ensure that the dish is fully covered with fibronectin solution. Fibronectin adheres to the

PDMS surface through non-specific binding, it is thus expected that other ECM proteins can

also adhere to the surface with a similar protocol.
STAR Protocols 1, 100098, September 18, 2020 5



Figure 2. Confluent Monolayer of AML12 Cells on PDMS Substrate

Representative phase contrast image of AML12 (A) seeded on PDMS substrate functionalized with fluorescent beads

(B). Scale bar, 100 mm.
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21. Remove fibronectin solution and wash PDMS dish 3 times with 3 mL of PBS.

22. Add 1 mL of 1% pluronic to PDMS dish for sterilization. Incubate at room temperature (�22�C–
25�C) for 30 min.

23. Remove pluronic and wash PDMS dish 3 times with 3 mL of PBS.

24. Seed cells onto PDMS dish so that a confluent monolayer is established in 24 h (Figure 2).

Note: This protocol can be adopted to measure traction forces from single cells as well.
Imaging

Timing: 26 h

25. Transfer dish to a widefield fluorescence microscope. For instance, we used the Nikon Ti-E In-

verted Microscope equipped with a Hamamatsu Flash 4.0 sCMOS camera, Lumencor 7 line

LED light source, motorized X-Y-Z stage, piezo Z-drive and a CO2 and temperature incubator

box.

26. Using a 103 (or 203) dry objective, acquire images of beads with a large field of view (e.g.,

1,000 3 1,000 mm depending on the camera and objective).

Note: It is advised to set up a single z-plane each for imaging channels of beads and cells as

they are usually not in the same focal-plane. In addition, ensure that images are captured and

saved as tiff files.

27. Determine the duration and time interval for capturing the movie. For instance, capturing an im-

age every 15 min for 24 h.

Note: The time interval is not important for traction force calculations, but is important to

correlate cell motion with the traction forces. For cells moving at �30 mm/h, a 10 min interval

is good. For cells moving at few mm/h, �60 min interval is enough.

28. At the end of a 24-h run, remove lid of the dish carefully and add 10% SDS.

Note 1: This detaches the cells and obtains the reference bead images when cells are no

longer exerting forces on the substrate (Style et al., 2014). Alternatives such as Trypsin and
6 STAR Protocols 1, 100098, September 18, 2020



Figure 3. Pre- and Post-24 h Imaging of AML12 Cells Seeded on PDMS Substrate Functionalized with Fluorescent

Beads

10% SDS was added to cells at the end of 24 h to remove the cells and to obtain the reference PDMS state. Scale bar,

100 mm.
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Triton X-100 could also be used to detach cells for the same purpose, but SDS has the advan-

tage of detaching cells within minutes. Do not remove the dish from the microscope to pre-

vent the loss of imaging positions. Generally, movement of the imaging position less than

�20% of the whole image allows the alignment software to work.

Note 2: Another way to obtain reference states is to make TFM samples on dishes pre-printed

with gridlines at the bottom, and image the reference state before cell seeding. The gridlines

will allow one to find the corresponding cell region for imaging after cells are seeded. This sec-

ond method eliminates the need to remove cells at the end of the experiment and allows for

cell fixing and staining of antibodies.

29. After �1 h, when substrate deformation is fully reversed, capture reference bead images.
EXPECTED OUTCOMES

A successful run should have cells adhered to the substrate at the end of the run prior to SDS treat-

ment (Figure 3). In addition, cell proliferation should be comparable to cells seeded on a dish

without PDMS during the imaging process (unless anti-proliferative drugs are added). This serves

as an indication that the cells are healthy and force measurements taken are not a result of cellular

toxicity.

Bead displacements can be converted to traction forces using an existing Matlab software, PIVlab

(Thielicke and Stamhuis, 2014) and ImageJ plugin: Fourier transform traction cytometry (FTTC, (Mar-

tiel et al., 2015, Tseng, 2011)). PIVlab measures the deformation map at each time frame. The FTTC

plugin further converts the deformation map to traction forces. We detail the parameters and steps

we use for analysis in the section below, but users are recommended to read the documentation

related to those software packages.
QUANTIFICATION AND STATISTICAL ANALYSIS

1. Install and Open ImageJ.

2. Create a folder on desktop and rename the folder (e.g., ‘‘Folder 1’’).

3. Repeat step 2 with the reference bead channel without cells (reference beads).

4. Concatenate maximum-projected beads channel with cells and reference beads channel.

a. ImageJ -> Stacks -> Tools -> Concatenate (Ensure that reference beads channel is Image1

and beads channel with cells is Image2).

5. Save concatenated image stack in Folder 1.
STAR Protocols 1, 100098, September 18, 2020 7
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6. Run ForBeads-CorrectDriftNGlaring-Align.ijm macro to align beads image and generate image

stack for PIV analysis.

a. Duplicate and rename the first frame as ‘‘Ref.’’

b. Duplicate the remaining stack without the first frame (e.g., Range 2-XX) and rename as ‘‘With-

Cells.’’

c. Run macro and save Transformation Matrix.

d. Save the new stack in 8-bit format as Image Sequence in Folder 1.
8 S
i. E.g., ForPIV001, ForPIV002, ForPIV_003, etc.
7. Run the PIVlab algorithm version 1.43 (Thielicke and Stamhuis, 2014) in Matlab

a. Open PIVlab and select Load images to import images.

b. In the Analyses setting tab, PIV settings used are as follows:
i. Interrogation windows with three pass: 128(64), 64(32), 32(16). The window size in the final

pass should have at least�5 beads for the correlation to proceed well (Martiel et al., 2015).

Note: We encourage new users to refer to the PIVlab video tutorial for more information on

how to navigate the software and learn best practices.

c. Click Analysis-> Analyze!

d. After analysis, under the post processing tab, click vector validation (Thielicke and Stamhuis,

2014)

i.Select ‘‘display all frames in.’’ and click on Refine velocity limits to remove outlier velocity
limits if necessary
ii. Select stdev filter 7, Local median filter threshold 5, epsilon 0.1.

iii. After selecting these parameters, Select Apply to all frames.

e. Save PIVlab session in Folder 1.

i.File -> Save -> PIVlab Session.

f.Export results to Matlab workspace.

i.File -> Save -> All results to Matlab workspace.

8. Convert PIVlab output files into .txt files using the code OutputTxtFilesForFTTC2.m.

Note: A supplemental dataset (Supplemental Data 1) is provided for users to perform a test run.

9. Using PIV.txt files, obtain traction forces by running the FTTC plugin in ImageJ (Tseng, 2011) with

a Poisson ratio of 0.5 (Martiel et al., 2015). Choose the stiffness depending on the mixing ratio

that the user has used to fabricate the PDMS (see step 1). Although a stiffness range was given

for each mixing ratio, users can take the midpoint of each range without loss of generality but

keeping in mind to consistently use the same value. A regularization parameter can be tuned

to remove highly fluctuating signals due to noise (Martiel et al., 2015). Note that traction force

outputs are in the units of Pascal (Pa).

Note: The higher the value of regularization, the more the traction forces output are

smoothed. The values suggested by Martiel et al. 2015 are �8e�11, but this is not a strict

guideline. An important rule of thumb is to choose a value which gives traction forces that

make sense, and use the same values when comparing between experimental conditions.

This mean that high spatial frequency components representing noise are not present. For

example, if one observes spatial traction values fluctuating much more rapidly than the

average distance between focal adhesions, it is advisable to increase the regularization value.
LIMITATIONS

Considering that polyacrylamide (PA) hydrogels and PDMS are the two most widely used classes of

materials for performing TFM, we provide a brief summary of their differences as well as recommen-

dation of use.
TAR Protocols 1, 100098, September 18, 2020



Table 1. Key Material Properties of PDMS and PA

PDMS PA Hydrogels

Minimum Stiffness Approximately 2 kPa On the order of 100 Pa

Permeability to medium and
ions

No Yes

Refractive index > 1.4 Approximately 1.33 (that of
water)

Uniformity of stiffness Treatment with oxygen
plasma can lead to a stiffer
surface compared to the bulk
PDMS.

More uniform stiffness
throughout the material

Mechanical property Viscoelastic. The type of
PDMS recommended here
has consistent viscosity when
varying stiffness down to
approximately 2 kPa,
allowing for better
characterization of cell
behavior as a function of
substrate stiffness (Kenry
et al., 2015)

Poroelastic (Casares et al.,
2015)

Surface functionalization
with proteins

Simple, non-specific binding Use of chemicals such as
Sulfo-Sanpah, but tricky in
general due to hydrophilicity
of hydrogels
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We suggest anyone new to the methodology of TFM should consider using PDMS as a substrate

instead of PA hydrogels. Importantly, PDMS is easy to fabricate and functionalize with extracellular

matrix proteins (e.g., Fibronectin) compared to PA gels. Like PA gels, PDMS also allows for micro-

contact printing and patterning of these proteins in extended-variants of this protocol (Vedula

et al., 2014). Further, PDMS does not exhibit poroelasticity as seen in PA hydrogels. This avoids com-

plex material deformation due to fluid flow, occurring at time-scales on the order of 10 min or more,

which can complicate the interpretation of traction force measurements (Casares et al., 2015).

However, we do recommend the use of PA hydrogels when low substrate stiffness (<1 kPa) and/or high-

resolution force maps are required (down to single Focal Adhesion resolution (Plotnikov et al., 2014)). PA

hydrogels are able to exhibit low substrate stiffness (on the order of 100 Pa) without drastically affecting

the solidity of thematerial at this stiffness range. In addition, with a largely uniform substrate stiffness and

a refractive index closer to water, more accurate inference of forces at the local scale and higher optical

resolution can be achieved. It is noteworthy that long-term culture (more than a few days) of epithelial

cells that are prone to pumping ions toward the substrate (e.g., MDCK cells) can affect the flat epithelial

morphology and induce three-dimensional, fluid-filled structures onnon-permeable PDMS (Latorre et al.,

2018). This can be partially circumvented by culturing cells on PA hydrogels that have sufficient gel thick-

ness, as these gels are permeable to liquid and allows the buffering of ion accumulation.

Table 1 below compares several important properties of PDMS and PA hydrogels that one should

take into consideration prior to performing TFM.

TROUBLESHOOTING

Problem 1

Beads in different areas are not in focus.

Potential Solution

This tends to happen when the PDMS substrate is not evenly spread. Make sure that the PDMS

mixture is dropped right in the center of the dish before spin coating. Ensure that the dish is

well-centered on the Spin coater before spinning. After spinning, perform a visual check to see if
STAR Protocols 1, 100098, September 18, 2020 9
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a uniform layer of the PDMSmixture is formed. There should be no visible accumulation of the PDMS

mixture in the dish.
Problem 2

Visible bubbles seen in cured PDMS substrate.
Potential Solution

Prior to spin coating, perform a visual check to ensure that there are no bubbles in the PDMSmixture.

If bubbles are present, use a pipette tip to pop the bubbles. Perform a second visual check after spin

coating to ensure that bubbles are absent before curing.
Problem 3

Imaging positions for reference beads images are not maintained after adding 10% SDS.
Potential Solution

If the microscope is equipped with a cage incubator, consider imaging the beads and (or) cells in the

dish without the lid on. To minimize evaporation of media during the imaging process, place Petri

dishes containing water near the sample to humidify the environment. Also, adding mineral oil

(which has a lower density than water) gently to the top of the media can help.
Problem 4

Beads are clumped up.
Potential Solution

Ensure that the bead solution is well sonicated. When using an ultrasonic bath, check that the bead

solution is well immersed in the water bath throughout the sonication process. In addition, vortex the

bead solution just before applying it onto PDMS substrate. In the event that beads are still clumping,

consider testing a range of sonication frequencies. A good sonication frequency to adopt would be

one that has 1) minimal beads lost, 2) fluorescence intensity similar to beads that have not been son-

icated and 3) homogenous beads mixture with minimal clumps.
Problem 5

Cells are dying.
Potential Solution

Check that the imaging set up is not causing phototoxicity. Perform a trial experiment to optimize

fluorescence lamp intensity and exposure time. If cells are dying prior to imaging, make sure that

fibronectin has attached to the substrate before cells are seeded by performing an antibody staining

for fibronectin. If fibronectin is not detected, increase the duration of fibronectin incubation and be

gentle during washes to ensure that fibronectin is not being washed off.
RESOURCE AVAILABILITY

Lead Contact

Further information and requests for resources should be directed to the Lead Contact, Thuan Beng

Saw (biestb@nus.edu.sg).
Materials Availability

No unique reagents were generated.
Data and Code Availability

No large dataset or new softwares were developed.
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